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1 Before installation
This section answers questions that might arise before the product installation.

1.1

Types of licenses (stand-alone and advanced
editions)

Acronis Backup & Recovery 11 licensing is based on the number of machines backed up by the
product.

Stand-alone editions
These are the following editions:





Acronis Backup & Recovery 11 Server for Windows
Acronis Backup & Recovery 11 Server for Linux
Acronis Backup & Recovery 11 Workstation

The stand-alone editions are designed for backing up the data of a single machine. With any of the
above licenses, you can install all the product components on the same machine only. You will be
asked for the license key of any of the above editions during the product installation.

Advanced editions (editions with centralized management)
These are the following editions:






Acronis Backup & Recovery 11 Advanced Server
Acronis Backup & Recovery 11 Virtual Edition
Acronis Backup & Recovery 11 Advanced Server SBS Edition
Acronis Backup & Recovery 11 Advanced Workstation

These editions are designed for backing up multiple machines. In addition to components that need
to be installed on a backed up machine, these editions include a management server that enables
centralized management, and storage nodes for storing backed up data on them. Unlike stand-alone
editions, advanced editions allow remote connection to a backed up machine.
As with stand-alone editions, a separate license is required for every machine you want to back up.
During installation of a licensed component (agent), you can either specify a license server or enter a
license key manually. Installation of other components is not licensed. For example, you can install as
many storage nodes as you wish - up to 50.
Components of stand-alone editions do not interact with the components of advanced editions.
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1.2

Acronis Backup & Recovery 11 components

This section contains a full list of Acronis Backup & Recovery 11 components with a brief description
of their functionality.
Acronis Backup & Recovery 11 includes the following main types of components.

Components for a managed machine (agents)
These are applications that perform data backup, recovery and other operations on the machines
managed with Acronis Backup & Recovery 11. Agents require a license to perform operations on
each managed machine. Agents have multiple features, or add-ons, that enable additional
functionality and so might require additional licenses.

Components for centralized management
These components, delivered with the advanced editions, provide centralized management
capability. Usage of these components is not licensed.

Console
The console provides Graphical User Interface and remote connection to the agents and other
Acronis Backup & Recovery 11 components. Usage of the console is not licensed.

Bootable media builder
With bootable media builder, you can create bootable media in order to use the agents and other
rescue utilities in a rescue environment.
Bootable Media Builder does not require a license if installed together with an agent. All add-ons to
the agent, if installed, will be available in a rescue environment. To install a media builder on a
machine without an agent, you need to enter the license key or have at least one license on the
license server. The license may be either available or assigned.

1.2.1

Agent for Windows

This agent enables disk-level and file-level data protection under Windows.

Disk backup
Disk-level data protection is based on backing up either a disk or a volume file system as a whole,
along with all the information necessary for the operating system to boot; or all the disk sectors using
the sector-by-sector approach (raw mode). A backup that contains a copy of a disk or a volume in a
packaged form is called a disk (volume) backup or a disk (volume) image. It is possible to recover
disks or volumes as a whole from such backup, as well as individual folders or files.

File backup
File-level data protection is based on backing up files and folders residing on the machine where the
agent is installed or on a network share. Files can be recovered to their original location or to another
place. It is possible to recover all files and folders that were backed up or select which of them to
recover.

6
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Other operations
Conversion to a virtual machine
Rather than converting a disk backup to a virtual disk file, which requires additional operations to
bring the virtual disk into use, Agent for Windows performs the conversion by recovering a disk
backup to a new virtual machine of any of the following types: VMware Workstation, Microsoft
Virtual PC, Parallels Workstation, Citrix XenServer Open Virtual Appliance (OVA) or Red Hat Kernelbased Virtual Machine (KVM). Files of the fully configured and operational machine will be placed in
the folder you select. You can start the machine using the respective virtualization software or
prepare the machine files for further usage.
Disk management
Agent for Windows includes Acronis Disk Director Lite - a handy disk management utility. Disk
management operations, such as cloning disks; converting disks; creating, formatting and deleting
volumes; changing a disk partitioning style between MBR and GPT or changing a disk label, can be
performed either in the operating system or using bootable media.

1.2.1.1

Universal Restore

The Universal Restore add-on enables you to use the restore to dissimilar hardware functionality on
the machine where the agent is installed and create bootable media with this functionality. Universal
Restore handles differences in devices that are critical for the operating system start-up, such as
storage controllers, motherboard or chipset.

1.2.1.2

Deduplication

This add-on enables the agent to back up data to deduplicating vaults managed by Acronis Backup &
Recovery 11 Storage Node.

1.2.2

Agent for Linux

This agent enables disk-level and file-level data protection under Linux.

Disk backup
Disk-level data protection is based on backing up either a disk or a volume file system as a whole,
along with all information necessary for the operating system to boot; or all the disk sectors using the
sector-by-sector approach (raw mode.) A backup that contains a copy of a disk or a volume in a
packaged form is called a disk (volume) backup or a disk (volume) image. It is possible to recover
disks or volumes as a whole from such backup, as well as individual folders or files.

File backup
File-level data protection is based on backing up files and directories residing on the machine where
the agent is installed or on a network share accessed using the smb or nfs protocol. Files can be
recovered to their original location or to another place. It is possible to recover all files and
directories that were backed up or select which of them to recover.

1.2.2.1

Universal Restore

The Universal Restore add-on enables you to use the restore to dissimilar hardware functionality on
the machine where the agent is installed and create bootable media with this functionality. Universal
7
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Restore handles differences in devices that are critical for the operating system start-up, such as
storage controllers, motherboard or chipset.

1.2.2.2

Deduplication

This add-on enables the agent to back up data to deduplicating vaults managed by Acronis Backup &
Recovery 11 Storage Node.

1.2.3

Agent for VMware vSphere ESX(i)

Acronis Backup & Recovery 11 Agent for VMware vSphere ESX(i) enables backup and recovery of
ESX(i) virtual machines without installing agents into the guest systems. This backup method is
known as agent-less backup or backup at a hypervisor level.
The agent is delivered in two versions:



Agent for VMware vSphere ESX(i) (Virtual Appliance) can be imported or deployed to a VMware
ESX(i) host.



For off-loaded backup, Agent for VMware vSphere ESX(i) (Windows) can be installed on a
machine running Windows.

Acronis Backup & Recovery 11 Agent for VMware vSphere ESX(i) is referred as Agent for ESX(i) later
in this document.

1.2.4

Agent for Hyper-V

Acronis Backup & Recovery 11 Agent for Hyper-V protects virtual machines residing on a Hyper-V
virtualization server. The agent allows for backing up virtual machines from the host without having
to install agents on each virtual machine. The agent installs on Windows 2008 Server x64 (any
edition) or Microsoft Hyper-V Server 2008.

1.2.5

Components for centralized management

This section lists the components included in the Acronis Backup & Recovery 11 editions that provide
the centralized management capability. Besides these components, Acronis Backup & Recovery 11
Agents have to be installed on all machines that need data protection.

1.2.5.1

Management Server

Acronis Backup & Recovery 11 Management Server is the central server that drives data protection
within the enterprise network. The management server provides the administrator with:
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a single entry point to the Acronis Backup & Recovery 11 infrastructure
an easy way to protect data on numerous machines using centralized backup plans and grouping
integration with VMware vCenter to discover virtual machines for protection
enterprise-wide monitoring and reporting functionality
built-in license management
the ability to create centralized vaults for storing enterprise backup archives
the ability to manage storage nodes
the centralized catalog of all data stored on the storage nodes.
Copyright © Acronis, Inc.

If there are multiple management servers on the network, they operate independently, manage
different machines and use different centralized vaults for storing archives.

1.2.5.2

Storage Node

Acronis Backup & Recovery 11 Storage Node is a server designed to optimize the usage of various
resources (such as the corporate storage capacity, the network bandwidth, or the managed
machines' CPU load) which are required to protect the enterprise data. This goal is achieved by
organizing and managing the locations that serve as dedicated storages of the enterprise backup
archives (managed vaults).
The most important function of a storage node is deduplication of backups stored in its vaults. This
means that identical data will be backed up to this vault only once. This minimizes the network usage
during backup and storage space taken by the archives.
The storage nodes enable creating highly scalable and flexible, in terms of the hardware support,
storage infrastructure. Up to 50 storage nodes can be set up, each being able to manage up to 20
vaults.
The administrator controls the storage nodes centrally from the Acronis Backup & Recovery 11
Management Server (p. 8). Direct console connection to a storage node is not possible.

1.2.5.3

Components for Remote Installation

These are Acronis component installation files which are used with the Remote Installation Wizard.
The setup program saves these files in the default location and saves this location path in the
registry. As a result, the components are readily available in the Remote Installation Wizard as
"registered components".
How to disable installation of the components
Components for Remote Installation are selected by default when you use the Connect to remote
machines or Centrally monitor and configure... check boxes in the setup program. Since the
installation files take about 600 MB of disk space, you may want to prohibit saving them locally every
time you install the console. For example, you can extract the installation files to a shared folder. The
files will be available for any management console that operates on the network. In the Remote
Installation Wizard, you will specify the shared folder path instead of selecting "registered
components".
To prohibit saving the installation files locally, select the I want to manually select the Acronis
components check box and clear the Components for remote installation check box in the next
window.

1.2.5.4

PXE Server

Acronis PXE Server allows for booting machines into Acronis bootable components through the
network.
The network booting:



Eliminates the need to have a technician onsite to install the bootable media into the system that
has to be booted

9
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During group operations, reduces the time required for booting multiple machines as compared
to using physical bootable media.

1.2.5.5

License Server

The server enables you to manage licenses of Acronis products and install the components that
require licenses.
For more information about Acronis License Server please see "Using Acronis License Server".

1.2.6

Management Console

Acronis Backup & Recovery 11 Management Console is an administrative tool for remote or local
access to Acronis Backup & Recovery 11 agents and, in the product editions that include the
centralized management capability, to the Acronis Backup & Recovery 11 Management Server.
The console has two distributions: for installation on Windows and installation on Linux. While both
distributions enable connection to any Acronis Backup & Recovery 11 agent and Acronis Backup &
Recovery 11 Management Server, we recommend that you use the console for Windows if you have
a choice between the two. The console that installs on Linux has limited functionality:




Remote installation of Acronis Backup & Recovery 11 components is not available.
The Active Directory-related features, such as browsing the AD, are not available.

1.2.7

Bootable Media Builder

Acronis Bootable Media Builder is a dedicated tool for creating bootable media. There are two media
builder distributions: for installation in Windows and installation in Linux.
The media builder that installs on Windows can create bootable media based on either Windows
Preinstallation Environment, or Linux kernel. The media builder that installs on Linux creates
bootable media based on Linux kernel.
The Universal Restore (p. 7) add-on enables you to create bootable media with the restore to
dissimilar hardware functionality. Universal Restore handles differences in devices that are critical for
the operating system start-up, such as storage controllers, motherboard or chipset.
The Deduplication (p. 7) add-on enables you to create bootable media with the back up to a
deduplicating vault functionality. This add-on can be installed to either of the media builder
distributions.

1.2.8

Acronis Wake-on-LAN Proxy

Acronis Wake-on-LAN Proxy enables Acronis Backup & Recovery 11 Management Server to wake up
for backup machines located in another subnet. Acronis Wake-on-LAN Proxy installs on any server in
the subnet where the machines to be backed up are located.

10
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1.3

Licensing of advanced editions

Acronis License Server
Licenses of advanced editions are managed by Acronis License Server. You can install a license server
as a separate component (p. 39) or use the one integrated into the management server. The
functionality of the license server is similar for both types of installation.
Acronis License Server can import multiple license keys from .txt or .eml files, saving you from the
time-consuming procedure of typing in numbers.

Specifying licenses during installation
During installation of a licensed component (agent), you can either specify the license server or enter
a license key manually. When you register the machine on the management server, the manually
entered key will be imported to the server and will be seen in the list of licenses.
Installation of an agent is possible without specifying a license or a license server in the following
cases:



When installing the software for online backup only. Such backup does not require a license, but
requires a subscription for the Acronis Backup & Recovery Online service.



When installing Agent for VMware vSphere ESX(i) (p. 8) (both versions). The licenses will be
consumed later, when a backup of the specified virtual machines starts. One Virtual Edition
license will be required for each host where a virtual machine is selected for backup.

Checking licenses
An Acronis agent connects to Acronis License Server every time the agent service starts and then
every 1–5 days, as specified by the agent configuration parameters. If the agent is unable to connect
to the license server, it initiates an alert. The agent keeps working without the license server for 1–60
days (as specified by the configuration parameters). After that it stops working until there has been a
successful license check.
If the agent connects to the license server but does not find the appropriate license, it tries to
acquire another license. If no license is available, the agent stops working until it succeeds in
acquiring the license.
By default, the agent tries to connect to the license server every day and keeps working without a
license server for 30 days.

1.3.1

How many licenses do I need?

Assume that your company network includes a server and five workstations running Windows. All
the machines are backed up by the administrator who prefers setting up and monitoring backups
from a single place. Therefore, you consider licenses for advanced editions. A license cost depends
on the operating system the software is installed in.
To protect all the machines, you need:
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Five licenses for Acronis Backup & Recovery 11 Advanced Workstation
One license for Acronis Backup & Recovery 11 Advanced Server or Advanced Server SBS Edition,
depending on the operating system your server is running.
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1.3.2

Licensing for virtual machines

Acronis offers a special licensing policy for virtual machines.



An Acronis Backup & Recovery 11 Advanced Server license enables the backing up of a physical
host and four virtual machines.



An Acronis Backup & Recovery 11 Virtual Edition license enables backing up a physical host and
an unlimited number of hosted virtual machines. You can install the product into the guest
systems, back them up from the host, or combine both methods.
Installation of Agent for VMware vSphere ESX(i) (both versions) is possible without specifying a
license or a license server. When creating a backup plan, one Virtual Edition license will be
required for each host where a virtual machine is selected for backup.

1.4

Supported operating systems

Components for a managed machine
Acronis Backup & Recovery 11 Agent for Windows
Acronis Backup & Recovery 11 Advanced Server
Acronis Backup & Recovery 11 Advanced Server Virtual
Windows XP Professional SP2+ (x86, x64)
Windows 2000 SP4 – all editions except for the Datacenter edition
Windows Server 2003/2003 R2 – the Standard, Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Vista – all editions except for Vista Home Basic and Vista Home Premium (x86, x64)
Windows 7 – all editions except for the Starter and Home editions (x86, x64)
Windows Server 2008 – the Standard, Enterprise editions (x86, x64)
Windows Small Business Server 2008
Windows Server 2008 R2 – the Standard, Enterprise, Datacenter, Foundation editions
Windows MultiPoint Server 2010
Windows Small Business Server 2011
Acronis Backup & Recovery 11 Advanced Server SBS Edition
Windows Small Business Server 2003/2003 R2
Windows Small Business Server 2008
Windows Small Business Server 2011
Acronis Backup & Recovery 11 Advanced Workstation
Windows 2000 Professional SP4
Windows XP Professional SP2+ (x86, x64)
Windows Vista – all editions except for Vista Home Basic and Vista Home Premium (x86, x64)
Windows 7 – all editions except for the Starter and Home editions (x86, x64)

Acronis Backup & Recovery 11 Agent for Linux
Acronis Backup & Recovery 11 Advanced Server
Acronis Backup & Recovery 11 Advanced Server Virtual
Linux with kernel 2.4.20 or later (including 2.6.x kernels) and glibc 2.3.2 or later
Various 32-bit and 64-bit Linux distributions, including:
12
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Red Hat Enterprise Linux 4.x, 5.x and 6.x
Ubuntu 9.10 (Karmic Koala), 10.04 (Lucid Lynx) and 10.10
Fedora 11, 12, 13, 14
SUSE Linux Enterprise Server 10 and 11
Debian 4 (Lenny) and 5 (Etch)
CentOS 5
Before installing the product on a system that does not use RPM Package Manager, such as
an Ubuntu system, you need to install this manager manually; for example, by running the
following command (as the root user): apt-get install rpm

Acronis Backup & Recovery 11 Agent for Hyper-V
Windows Server 2008/2008 R2 (x64) with Hyper-V
Microsoft Hyper-V Server 2008/2008 R2

Acronis Backup & Recovery 11 Agent for ESX(i) (Virtual Appliance)
This agent is delivered as a virtual appliance for running on an ESX(i) host.
VMware ESX Infrastructure 3.5 Update 2+
VMware ESX(i) 4.0 and 4.1

Acronis Backup & Recovery 11 Agent for ESX(i) (Windows)
This agent is delivered as a Windows application for running in any operating system listed above for
Agent for Windows (Advanced Server Virtual).

Components for centralized management
Acronis Backup & Recovery 11 Management Server, Acronis License Server, Acronis Backup &
Recovery 11 Storage Node
Windows XP Professional SP3 (x86, x64)
Windows Server 2003/2003 R2 – the Standard, Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Vista – all editions except for Vista Home Basic and Vista Home Premium (x86, x64)
Windows 7 – all editions except for the Starter and Home editions (x86, x64)
Windows Server 2008 – the Standard, Enterprise editions (x86, x64)
Windows Small Business Server 2008
Windows Server 2008 R2 – the Standard, Enterprise, Datacenter, Foundation editions
Windows MultiPoint Server 2010
Windows Small Business Server 2011
Acronis Backup & Recovery 11 Management Console
Windows XP Professional SP2+ (x86, x64)
Windows 2000 SP4 – all editions except for the Datacenter edition
Windows Server 2003/2003 R2 – the Standard, Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Vista – all editions (x86, x64)
Windows 7 – all editions (x86, x64)
Windows Server 2008 – the Standard, Enterprise editions (x86, x64)
13
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Windows Small Business Server 2008
Windows Server 2008 R2 – the Standard, Enterprise, Datacenter, Foundation editions
Windows MultiPoint Server 2010
Windows Small Business Server 2011

1.5

System requirements

The components installed in operating systems
Component

Memory (above
the OS and
running
applications)

Disk space required Disk space occupied Additional
during installation or by the component(s)
update

The components installed in Windows
Complete installation

300 MB

3.6 GB

1.99 GB
including SQL
Express Server

Agent for Windows

120 MB

1.3 GB

425 MB

Agent for VMware vSphere
ESX(i) (Windows)

See "Agent for
Windows"

1.3 GB

450 MB

Agent for Hyper-V

See "Agent for
Windows"

50 MB

20 MB

Bootable Media Builder

80 MB

1.1 GB

305 MB

CD-RW or DVD-RW
drive

Management Console

30 MB

950 MB

110 MB

Screen resolution
1024*768 pixels or
higher

Management Server

40 MB

440 MB

245 MB

400 MB for SQL
Express Server

400 MB for SQL
Express Server

Wake-on-LAN Proxy

Negligible

50 MB

10 MB

Storage Node
(general requirements)

100 MB

350 MB

185 MB

Storage Node
(recommendations for using
deduplication)

 Minimum 8 GB of RAM.

(7.5 GB
recommended)

When using a tape
library, space
required for tapes
database: approx.
1 MB per 10
archives

 64-bit platform. A 32-bit system can effectively process not more than 400 GB
of unique data.
For more information, see “Deduplication best practices” in the product Help or
the User Guide.

License Server
14

Negligible

50 MB

20 MB
Copyright © Acronis, Inc.

PXE Server

5 MB

80 MB

20 MB

The components installed in Linux
Complete installation

160 MB

895 MB

485 MB

Agent for Linux

65 MB

255 MB

160 MB

Bootable Media Builder

70 MB

495 MB

270 MB

Management Console

25 MB

145 MB

90 MB

The components installed on VMware ESX(i) server
Agent for VMware vSphere
ESX(i) (Virtual Appliance)

1 GB

5 GB

5 GB

(the Virtual
Appliance
memory setting)

CPU number:
2 (the default
Virtual Appliance
setting)
4-8 (recommended
if backing up 5-10
VMs
simultaneously)
CPU reservation:
minimum 300 MHz
recommended

Network interface card or virtual network adapter is a common requirement for all the components.

Bootable media
Media type

Memory

ISO image size

Based on Windows PE

640 MB

300 MB

Linux-based

512 MB

310 MB

15
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2 Installing Acronis Backup & Recovery 11
This section helps answer questions that might arise during the product installation.

2.1

Installation in Windows

This section describes installation of Acronis Backup & Recovery 11 components on a machine
running Windows.

2.1.1

Ways of installation in Windows

Components of advanced editions of Acronis Backup & Recovery 11 can be installed in different
ways. Based on the size and structure of your environment, choose any of the ways of installation
described in this section.
You can combine two or more ways of installation. For example, you can perform interactive
installation of the management console and the management server, and then remotely install the
agents to multiple machines.
By using interactive or Web-based installation, you can install any component. Other ways of
installation are intended primarily for installing the agents.

Interactive installation (p. 18)
In this way of installation, you run a self-contained setup program and follow the on-screen
instructions.
Advantages: The setup program includes all components for Windows.
Disadvantages: Large size of the setup program.
Usage examples:




Installing the management console, management server and storage nodes.
Installing agents on a small number of machines.

Web-based installation (p. 22)
In this way of installation, you run a lightweight setup program and follow the on-screen instructions.
The setup program downloads from the Acronis Web site only the components that you selected to
install.
Advantages: Small size of the setup program.
Disadvantages: Large amounts of the same data may be transferred over the Internet (for example,
when installing the agent on many machines). To overcome this disadvantage, save the downloaded
installation files (p. 22) to a network folder.
Usage examples: Installing agents in a small network with slow Internet access (you do not need to
download the large setup program from the Acronis Web site).

16
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Remote installation (p. 25)
Prerequisite: the management console must be already installed.
In this way of installation, you install the software remotely on a number of machines. You can do
this from the management console’s welcome screen or when adding machines to the management
server.
Advantages: Installation can be performed centrally by an administrator and is transparent to end
users.
Disadvantages: Several preparatory steps (p. 25) must be performed on the target machines before
installation.
Usage examples:




Installing agents on a large number of machines in a local network.
Adding a machine without an agent to the management server.

Unattended installation (p. 22)
In this way of installation, you run installation packages (.msi files) with command-line parameters.
Advantages: Installation can be performed by a script.
Disadvantages: Installation is harder to configure (you may need to create a transform, or an .mst
file).
Usage examples: Installing agents on a large number of machines running Windows.

Installation through Group Policy (p. 28)
In this way of installation, you deploy installation packages (.msi files) in an Active Directory domain
by using Group Policy.
Advantages: Installation can be performed centrally by an administrator in an entire domain. It is
performed under a system account and is transparent to end users.
Disadvantages: Installation is harder to configure (you may need to create a transform, or an .mst
file). The machines must be in a domain.
Usage examples: Installing agents on a large number of machines in an Active Directory domain.

Installation from the management server Web page (p. 34)
Prerequisite: the management server must be already installed.
In this way of installation, you go to the Web page on the management server, and install the
software without having to specify installation settings.
Advantages:





17

Installation can be performed by an end user on any machine with a supported Web browser.
The components are downloaded from the local network instead of over the Internet.
The end user does not need to specify installation settings.
The machine can be automatically registered on the management server.
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Disadvantages: The end user still must have rights to install software on the machine (for example,
be a local administrator on it).
Usage examples:



Enabling laptop users (who may connect to the corporate network at irregular intervals) to install
the program on their own.



Accessing installation packages in a network that does not allow sharing folders.

2.1.2

Local installation

You have a choice between a setup program that contains all components, and a lightweight setup
program that will download from the Acronis Web site only the components that you select to install.
Installation can be performed in the interactive or the unattended mode.

2.1.2.1

Preparation

Network port. Acronis Backup & Recovery 11 uses TCP port 9876 for local installation and for
communication between components. The setup program automatically opens this port through
Windows Firewall. If you use a different firewall, make sure that the port is open for both incoming
and outgoing requests through that firewall.
Encryption software. If you are planning to use disk-level encryption software, such as PGP Whole
Disk Encryption, make sure to install such software before installing Acronis Backup & Recovery 11.

2.1.2.2

Interactive installation in advanced editions

Do the following to install Acronis Backup & Recovery 11 on the local machine:
1.
2.
3.
4.

Log on as an administrator and start the Acronis Backup & Recovery 11 setup program.
Click Install Acronis Backup & Recovery 11.
Accept the terms of the license agreement.
Select one or more check boxes, depending on what you want this machine to do. Based on your
choice, the corresponding components of Acronis Backup & Recovery 11 will be preselected for
installation.
To review the list of preselected components or to select additional components, such as an
Agent for VMware vSphere ESX(i), select the I want to manually select the Acronis
components… check box. In this case, you also will be able to specify additional parameters (see
step 8).
5. If prompted, select whether to install the Deduplication and/or the Universal Restore
component. These components require additional license keys.
6. When installing a component that requires a license key (for example, an Agent for Windows),
specify where to take the license keys from:
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Take license keys from license server
The component will take the license key from a license server. Specify the name or IP address
of the machine with the license server. If you are installing the management server on this
machine, you can specify the integrated license server (recommended) or the license server
installed on a different machine.
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Select the product edition that you want to install. If the license server stores licenses for
more than one edition, the setup program suggests the cheapest applicable license based on
the machine’s operating system.



I will enter the keys manually
You will need to type the license keys or to import them from a file.
This option is not available if you selected an Agent for VMware vSphere ESX(i) (Windows).



I want to back up this machine to online storage only
No license keys will be used. You will be able to back up this machine only to Acronis Online
Backup Storage.
7. Specify the folder where the product will be installed. In this window, you can also change the
folder where files for remote installation (p. 25) will be placed.
8. If prompted, specify one or more of the following parameters depending on your component
selection:




Whether to install the product for all users or only for the current user.



Credentials for the Acronis Backup & Recovery 11 component services. By default, the setup
program will create a dedicated user account for each service. See "Specifying credentials for
Acronis services (p. 19)".



The names of Microsoft SQL servers to be used by Acronis Backup & Recovery 11
Management Server. See "Specifying Microsoft SQL servers (p. 21)".



Whether to register Acronis Backup & Recovery 11 Agent for Windows and/or Acronis
Backup & Recovery 11 Storage Node on the management server. See "Registering
components on the management server (p. 21)".



The names of users who will be allowed to connect to the machine remotely. See "Specifying
users allowed to connect remotely (p. 22)".



The name or IP address of VMware vCenter Server or ESX(i) Server whose virtual machines
Agent for ESX(i) (Windows) will back up. Specify the user name and password for logging on
to that server. If you do not want to specify the server, click I will specify the server later.

Whether to enable the management server Web page (p. 34), and the port for the Web page
(p. 37).

To access this setting after the agent has been installed, connect the console to the machine with the
agent and select from the top menu Options > Machine options > Agent for ESX(i).

9. Choose whether the machine will participate in the Acronis Customer Experience Program (CEP).
The summary page displays the list of components that will be installed on the machine, and the
installation settings for those components.
Note: When canceling the installation process, only the last package is removed. Other components, if any,
remain installed.

Specifying credentials for Acronis services
The Acronis Backup & Recovery 11 Agent for Windows, Acronis Backup & Recovery 11 Agent for
VMware vSphere ESX(i) (Windows), Acronis Backup & Recovery 11 Management Server, and Acronis
Backup & Recovery 11 Storage Node components run as services. When installing any of these
components, you need to specify the account under which the component's service will run.
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For each service, you can either create a dedicated user account (recommended in most cases) or
specify an existing account of a local or domain user—for example: .\LocalUser or
DomainName\DomainUser.

New accounts
If you choose to create dedicated user accounts for the services, the setup program will create the
following user accounts:



For the service of Acronis Backup & Recovery 11 Agent for Windows and Acronis Backup &
Recovery 11 Agent for VMware vSphere ESX(i) (Windows), Acronis Agent User




For the service of Acronis Backup & Recovery 11 Management Server, AMS User
For the service of Acronis Backup & Recovery 11 Storage Node, ASN User

The newly created accounts are given the following privileges:




All three accounts are assigned the Log on as a service user right.



The Acronis Agent User and ASN User user accounts are included in the Backup Operators and
Administrators groups.



The AMS User user account is included in the Acronis Centralized Admins group.

The Acronis Agent User user account is assigned the Adjust memory quotas for a process,
Replace a process level token and Modify firmware environment values user rights.

Existing accounts
The setup program will assign the above listed user rights to any existing account you specify for a
corresponding service.
If you choose to specify an existing user account for the agent service, make sure that this account is
a member of the Backup Operators group before proceeding with the installation. For advanced
editions, we recommend that the account be a member of the Administrators group. Otherwise, the
Microsoft Software Shadow Copy provider may fail to take snapshots during centralized backups.
If you choose to specify an existing user account for the storage node service, make sure that this
account is a member of the Administrators group before proceeding with the installation. Otherwise,
the service may lack access to some Windows resources.
If you choose to specify an existing user account for the management server service, this account will
be added to the Acronis Centralized Admins group automatically.
When installing an agent on a failover cluster node, such as a Hyper-V cluster node, specify an
existing account of a domain user for the agent service. The account must have administrative
privileges on each of the cluster nodes. With this account the agent will be able to access the
clustered resources on any of the nodes. Alternatively, you can choose to create a new account for
the agent. Then, when creating centralized backup plans or recovery tasks, you will need to specify
credentials for the domain account with the necessary privileges.

Tips for further usage


If the machine is part of an Active Directory domain, make sure that the domain's security
policies do not prevent the accounts described in this section (whether existing or newly created)
from having the above listed user rights.



After the installation, do not specify a different user account for a component's service.
Otherwise, the component may stop working.

20

Copyright © Acronis, Inc.

Specifying Microsoft SQL servers
When installing Acronis Backup & Recovery 11 Management Server, you need to specify the
Microsoft SQL servers for the management server's databases:



The operational SQL server ensures synchronization of the Acronis Backup & Recovery 11
components. It stores a database with rapidly changing operational data.



The reporting SQL server stores the operation log and statistics. The databases stored on this
server may become considerably large over time.

For each SQL server, select one of the following:



Microsoft SQL Server 2005 Express that comes with the installation package and installs on the
same machine. In this case, an SQL server instance will be created on the machine.




Microsoft SQL Server 2008 (any edition) previously installed on any machine.
Microsoft SQL Server 2005 (any edition) previously installed on any machine.

Recommendations
For the operational SQL server, we recommend selecting a server that resides on the same machine
as the management server—for example, Microsoft SQL Server 2005 Express that comes with the
installation package.
For the reporting SQL server, you can choose the same server as for the operational SQL server, or a
different server—not necessarily on the same machine.

Registering components on the management server
When installing Acronis Backup & Recovery 11 Agent for Windows, Acronis Backup & Recovery 11
Agent for VMware vSphere ESX(i) (Windows), or Acronis Backup & Recovery 11 Storage Node, you
need to specify whether to register these components on Acronis Backup & Recovery 11
Management Server.
After the agent is registered on the management server, the machine can be centrally managed by
management server administrators. Such machine is called a registered machine.
After the storage node is registered on the management server, registered machines can back up
data to and recover data from the storage node's centralized vaults.

To register the agent and/or the storage node during installation (recommended)
1. Click Register now.
2. Specify the name or IP address of the machine with the management server. That machine must
be online. It can be the local machine—for example, when the management server is among the
components you are installing.
3. Specify the user name and password of a user who is a member of the Acronis Centralized
Admins group on the management server's machine. If you are installing the management server
on the local machine, specify the user name and password of a member of the Administrators
group.

To skip registration
 Click I will register the machine later (or I will register the components later).
After the installation, you can register the components on the management server or remove them
from it, through the management server's interface.
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Specifying users allowed to connect remotely
When installing an agent or the management server (or both), you need to specify the list of users
whom you want to allow to manage the machine remotely by using Acronis Backup & Recovery 11
Management Console.
By default, the list contains all members of the Administrators group on the machine; note that this
includes the domain administrators (if the machine is in an Active Directory domain).
The setup program creates the Acronis Remote Users group and adds the listed users to it. By adding
or removing group members, you will add or remove users who are allowed to connect to the
machine remotely.

2.1.2.3

Web-based installation

The procedure for Web-based installation is identical to that for interactive installation (p. 18). Webbased installation is available only in advanced editions.
During a Web-based installation, only the components that you are currently installing are
downloaded from the Acronis Web site. You should keep this in mind if you are planning to install
components from this machine remotely (p. 25) at a later time. To make sure that all components
that can be installed remotely are present on the machine, consider using local installation instead.
When performing Web-based installation on a large number of machines, you may want to avoid
multiple downloads of the same component over the Internet. To do this:
1. In your local network, create a shared folder and make it available to all machines where you
want to install Acronis Backup & Recovery 11.
2. On the first of these machines, do the following:
a. Run the setup program for Web-based installation.
b. In the corresponding window, select the Save the downloaded installation files check box,
and then specify the shared folder that you created.
c. Proceed with the installation.
The necessary installation files will be downloaded to the shared folder.
3. Perform steps a–c on the remaining machines. The setup program will reuse the installation files
that are already in the folder, instead of downloading them again. Any other necessary files will
be downloaded to the folder.

2.1.2.4

Unattended installation

Components of Acronis Backup & Recovery 11, such as Acronis Backup & Recovery 11 Agent for
Windows, can be installed in the unattended mode, as opposed to the interactive mode.
Some components require a file known as a transform (an .mst file). To create a transform for a
component, you need the configuration script mst_gen.vbs. This script is located in the folder
where Acronis Backup & Recovery 11 Management Console is installed. By default, the folder name
is C:\Program Files\Acronis\BackupAndRecoveryConsole. If the management console is installed on a
different machine, you can copy the script from that machine. See also “Examples of creating a
transform” later in this section.
The following components and features can be installed, reinstalled, or updated in the unattended
mode:
22
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Agent Core (required by any agent)



Acronis Backup & Recovery 11 Agent Core: AcronisAgentCore.msi (requires a transform)

Agents



Acronis Backup & Recovery 11 Agent for Windows: AcronisAgentWindows.msi (requires a
transform)



Acronis Backup & Recovery 11 Agent for VMware vSphere ESX(i) (Windows):
AcronisAgentESX.msi (requires a transform)



Acronis Backup & Recovery 11 Agent for Hyper-V: AcronisAgentHyperV.msi (requires a
transform)

Agent features




Acronis Backup & Recovery 11 Deduplication: AcronisDeduplication.msi (requires a transform)
Acronis Backup & Recovery 11 Universal Restore: AcronisUniversalRestore.msi (requires a
transform)

Bootable media builder



Acronis Backup & Recovery 11 Bootable Media Builder:
AcronisBootableComponentsMediaBuilder.msi (requires a transform)

Management console



Acronis Backup & Recovery 11 Management Console for advanced editions:
AcronisManagementConsole.msi



Acronis Backup & Recovery 11 Management Console for stand-alone editions:
AcronisStandaloneManagementConsole.msi

Order of installation for an agent
When you install an agent, first install the Agent Core component (if it is not yet installed), then the
agent itself, and then the agent features.

Installation procedure
To install, reinstall, or update a component in the unattended mode
1. Start the setup program.
2. Click Extract installation files (when using the standard setup program) or Save installation files
(when using the Web-based setup program).
3. Extract the component's installation package.
4. If you are installing a component that requires a transform, create the transform by running the
configuration script. Otherwise, skip this step.
For example, the following command creates a transform to install Agent for Windows with the
license key ABCDE-54321:
mst_gen.vbs /msi_path C:\AcronisAgentWindows.msi /serial ABCDE-54321

See also the examples later in this section. The complete syntax of the configuration script is
described in "Configuration script parameters" (p. 31).
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5. Do either of the following, depending on whether you are installing, reinstalling, or updating the
component:



If you are installing the component, run Windows Installer (the msiexec program) as
follows:
When installing a component that requires a transform (in this example, Agent for
Windows):
msiexec /i c:\AcronisAgentWindows.msi TRANSFORMS=AcronisAgentWindows.mst
/qb

Otherwise (in this example, the management console):
msiexec /i c:\AcronisManagementConsole.msi /qb



If you are reinstalling or updating the component, run Windows Installer as follows:
When reinstalling or updating a component that requires a transform (in this example, Agent
for Windows):
msiexec /i C:\AcronisAgentWindows.msi TRANSFORMS=C:\AcronisAgentWindows.mst
ADDLOCAL=ALL /qb

Otherwise (in this example, the management console):
msiexec /i C:\AcronisManagementConsole.msi ADDLOCAL=ALL /qb /l*v C:\log.log

In an Active Directory domain, another way of performing unattended installation, reinstallation, or
update of a supported component is through Group Policy—see "Installing the agent through Group
Policy (p. 28)".

Examples of creating a transform
Transform for Agent Core. The following command creates a transform for the installation package
of the Agent Core component:
mst_gen.vbs /msi_path C:\AcronisAgentCore.msi /account mydomain\agentuser
MyPassWd /ams_address managementsrv /ams_user adminname AdminPassWd

After unattended installation with this transform:



The agents’ service will run under the agentuser domain user account (of the mydomain
domain) whose password is MyPassWd.



The agents will be registered on Acronis Backup & Recovery 11 Management Server installed on
the managementsrv machine; adminname and AdminPassWd are respectively the user name
and password of a management server administrator.

Transform for Agent for Windows. The following command creates a transform for the installation
package of Agent for Windows:
mst_gen.vbs /msi_path C:\AcronisAgentWindows.msi /license_server licensesrv
/product AS

After unattended installation with this transform:



The agent will use a license for the Acronis Backup & Recovery 11 Advanced Server edition, by
taking it from the license server installed on the licensesrv machine.

Similarly, you can create transforms for the agent features such as Universal Restore.
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2.1.2.5

Update

To update one or more Acronis Backup & Recovery 11 components:
1.
2.
3.
4.
5.

Run the setup program of the updated version of Acronis Backup & Recovery 11.
Click Install Acronis Backup & Recovery 11.
Click Update.
If prompted, specify the license keys, by typing them manually or by specifying the license server.
Follow the on-screen instructions.

Updating components in the unattended mode
For information about updating a component in the unattended mode, see "Unattended installation
(p. 22)".

2.1.3

Remote installation

Components of Acronis Backup & Recovery 11, such as the agent for Windows, can be installed
remotely to one or more machines running Windows.
To perform remote installation, you need administrator privileges on the target machines.
You can perform remote installation in any of these ways:




From the management console
When adding one or more machines to the management server

2.1.3.1

Preparation

1. For successful installation on a remote machine running any Windows XP version, the option
Control panel > Folder options > View > Use simple file sharing must be disabled on that
machine.
2. For successful installation on a remote machine running Windows Vista or later, User Account
Control (UAC) must be disabled. To access this option, go to Control panel > User Accounts >
Change User Account Control Settings.
3. File and Printer Sharing must be enabled on the remote machine. To access this option:



On a machine running Windows XP with Service Pack 2 or Windows 2003 Server: go to
Control panel > Windows Firewall > Exceptions > File and Printer Sharing.



On a machine running Windows Vista, Windows Server 2008, or Windows 7: go to Control
panel > Windows Firewall > Network and Sharing Center > Change advanced sharing
settings.
4. Acronis Backup & Recovery 11 uses TCP ports 445 and 25001 for remote installation. Make sure
that these ports are added to exceptions in the firewall settings on the remote machines. TCP
port 445 is added to exceptions automatically by Windows Firewall when you enable File and
Printer Sharing.
To add a port to exceptions:
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In Windows XP and Windows Vista: go to Control panel > Windows Firewall > Exceptions >
Add Port



In Windows 7: go to Control panel > Windows Firewall > Advanced settings > Inbound
Rules > New Rule > Port
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Tip: If the remote machines are members of an Active Directory domain and use no firewall other than
Windows Firewall, you can add TCP port 25001 to exceptions by using Group Policy. On a domain
controller, create a Group Policy object, then go to Administrative Templates > Network > Network
Connections > Windows Firewall > Domain Profile > Windows Firewall: Define port exceptions (or: Define
inbound port exceptions), and then add the following port exception:
25001:tcp:*:enabled:Acronis remote install

You can exclude both ports from exceptions after the remote installation is complete.

2.1.3.2

Installation procedure

Do the following to install components of Acronis Backup & Recovery 11 remotely:
1. Start the remote installation in any of these ways:



From the management console: Start the management console. On the Tools menu, click
Install Acronis components.



When adding one or more machines to the management server: Connect the management
console to the management server. On the Actions menu, click Add a machine or Add
multiple machines.
2. Select the machines (p. 26) on which the components are to be installed. When adding a single
machine to the management server, just specify that machine's name or IP address, and the
administrator's user name and password on it.
3. Specify the components (p. 27) that you want to install. Please keep in mind that the component
features, such as Deduplication, cannot be installed if the main component is not installed or
selected for installation.
4. If prompted, specify the following:






License keys (p. 27) for the components that require them, such as the agents
Installation options for the agents, such as the user account for the agent’s service (p. 19). In
most cases, you should leave the default settings
Whether to register the machines on the management server after agent installation
Whether the machines will participate in Acronis Customer Experience Program (CEP)

The summary window displays a list of machines where the components will be installed.
Once the installation starts, the program displays the operation progress and the name of the
machine on which the components are being installed.

Update
To update one or more components on a remote machine, repeat the installation procedure.

Upgrade to a full version
To upgrade one or more components from a trial to a full version, specify the full license keys for
these components (for example, by importing them to the license server), and then repeat the
installation procedure. To upgrade from a trial version to a version for online backup only, repeat the
installation procedure without specifying license keys.
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Specifying the list of machines
When adding multiple machines to the management server or when performing remote installation,
specify the list of machines. This can be done by:



Typing machine names or IP addresses: click By IP/Name. Provide the administrator's user name
and password for each machine.



Browsing the network: click From network. When browsing the network, you can select
individual machines, as well as entire workgroups or domains. Provide the administrator's user
name and password for each machine. If there is a universal administrator account on the
network, enter the account credentials for one machine and set the option to apply it to all the
machines that you select. Domain administrator credentials and universal credentials for
workgroups can be applied in this way.



Browsing an Active Directory domain: click From Active Directory. Provide a universal
administrator account for the machines, such as domain administrator credentials.



Importing the list of the machines from .txt or .csv files: click From file. Provide a universal
administrator account for the machines.

Note: For a machine which is a domain controller in an Active Directory domain, you must specify the name of
that domain together with the user name. For example: MyDomain\Administrator

When you specify machines to add to the management server, Acronis Backup & Recovery 11
detects on which of these machines the agent is not yet installed. We recommend that you wait until
this detection is complete. Otherwise, only the machines with an already installed agent will be
added to the management server. To cancel this detection, click Cancel status detection.

Specifying the components for remote installation
Components are installed from installation packages. By default, the software takes these packages
from the folder %CommonProgramFiles%\Acronis\RemoteInstaller.
To select a different location of the installation packages of the components, click Change
components source. The selection Registered Components corresponds to the default folder.
If the console is connected to the management server, the software will take the packages from the
machine with the management server. If the console is not connected to the management server,
the software will take the packages from the machine with the console.

Specifying the license keys
When installing components that require licenses, provide the license keys in any of these ways:



Click Specify license keys manually and click Next. You will be able to type the license keys or
import them from a text file.



Click Use licenses from the following license server, specify the name or IP address of the license
server or the management server, and click Next.



Click Back up to Online Storage only and click Next. No license keys will be used. An agent
installed without a license key can perform backup only to Acronis Online Backup Storage.

The software automatically assigns the currently available licenses to the components.
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The Licensing window shows how many licenses are required and how many of them you still need
to assign to the components. To add one or more licenses, click Add license. You can provide trial
license keys, full license keys, or their combination.
To view or change the assignment of licenses, click View license mapping. In the License Mapping
window, you can set up which component will use which license, as follows:
1. Click a machine in the Machines view.
2. Under Components, examine which components on the machine require licenses.
3. Under Used Licenses, assign or reassign the licenses for these components by selecting or
clearing the corresponding check boxes.

2.1.4

Installing the agent through Group Policy

You can centrally install (or deploy) Acronis Backup & Recovery 11 Agent for Windows onto machines
that are members of an Active Directory domain, by using Group Policy. Group Policy is a mechanism
available in Microsoft Windows 2000 Server and later Windows server operating systems.
In this section, you will find out how to set up a Group Policy object to deploy Acronis Backup &
Recovery 11 Agent for Windows onto machines in an entire domain or in its organizational unit.
Every time a machine logs on to the domain, the resulting Group Policy object will ensure that the
agent is installed on the machine.

2.1.4.1

Prerequisites

Before proceeding with agent deployment, make sure that:



You have an Active Directory domain with a domain controller running Microsoft Windows
Server 2003 or later.




You are a member of the Domain Admins group in the domain.



You have a machine running Windows, with Acronis Backup & Recovery 11 Management Console
is installed on the machine.

You know the license key or the name or IP address of a machine where Acronis License Server is
installed.

2.1.4.2

Preparing the agent's deployment

Step 1: Extracting installation packages
You need to create a shared folder that will contain the installation packages (provided as .msi files),
and extract the packages there.
1. On the domain controller (or any other machine in the domain), create a folder—for example:
D:\Acronis
2. Start the Acronis Backup & Recovery 11 setup program.
3. Click Extract installation files.
4. Select the Agent for Windows (AcronisAgentWindows.msi) and Agent Core
(AcronisAgentCore.msi) check boxes.
5. If you are installing Acronis Backup & Recovery 11 Deduplication, select the Deduplication
(AcronisDeduplication.msi) check box.
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6. If you are installing Acronis Backup & Recovery 11 Universal Restore, select the Universal
Restore (AcronisUniversalRestore.msi) check box.
Note: In Acronis Backup & Recovery 11 Virtual Edition and Advanced Server SBS Edition, the Universal
Restore feature is already enabled, so you do not need to install it separately.

7. In Extract to, type the name of the folder that you just created, or click Browse and select the
folder.
8. Click Extract.
9. Share the folder where you placed the installation packages. Make sure that domain users can
access the shared folder—for example, by leaving the default sharing settings for Everyone.

Step 2: Configuring the installation packages
Important: Skip this step when reinstalling or updating the agent.

You need to configure the installation packages of the Agent Core and Agent for Windows
components by running the configuration script. The script is installed along with the management
console. By default, the script is located in the folder
%ProgramFiles%\Acronis\BackupAndRecoveryConsole. If the management console is installed on a
different machine, you can copy the configuration script from that machine.
The configuration script creates a transform (also known as a modification, a modification file, or an
.mst file) for an installation package.
1. In the Start menu, click Run, and then type: cmd
2. Click OK.
3. Change the current folder to the one where the configuration script mst_gen.vbs is located, by
running commands such as:
C:
cd "C:\Program Files\Acronis\BackupAndRecoveryConsole"

4. Run the configuration script for the Agent Core and for the Agent for Windows components; for
example, as follows:
mst_gen.vbs /msi_path D:\Acronis\AcronisAgentCore.msi
mst_gen.vbs /msi_path D:\Acronis\AcronisAgentWindows.msi /license_server
licensesrv /product AS
Note: You must include a complete path to the installation package, even if the package is in the same
folder as the configuration script.

For the complete syntax of the configuration script, see Configuration script parameters (p. 31).
See also “Examples of creating a transform” in Unattended installation (p. 22).
The installation packages are ready for deployment. You now need to create Group Policy objects, as
described in Setting up the Group Policy objects (p. 29).

2.1.4.3

Setting up the Group Policy objects

Use this procedure to set up a Group Policy object (GPO) for agent deployment in the entire domain
or in its organizational unit. The agent will be installed on each machine which is a member of the
domain or the organizational unit immediately after Windows starts on that machine.
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Prerequisites


You must be logged on to the domain controller as a domain administrator; if the domain has
more than one domain controller, log on to any of them as a domain administrator.



If you are planning to deploy the agent in an organizational unit, make sure that the
organizational unit exists in the domain.



Make sure that you have completed the steps described in Preparing the agent's deployment.

Step 1: Creating Group Policy objects
1. In the Start menu, point to Administrative Tools, and then click Active Directory Users and
Computers (in Windows Server 2003) or Group Policy Management (in Windows Server 2008).
2. In Windows Server 2003:



Right-click the name of the domain or organizational unit, and then click Properties. In the
dialog box, click the Group Policy tab, and then click New.
In Windows Server 2008:



Right-click the name of the domain or organizational unit, and then click Create a GPO in this
domain, and Link it here.
3. Name the new Group Policy object Acronis Agent
4. Similarly, create another Group Policy object and name it Acronis Core
5. Make sure that the Acronis Agent object is higher in the list than the Acronis Core object.

Step 2: Configuring the Group Policy object for the agent
1. Open the Acronis Agent Group Policy object for editing, as follows:



2.
3.
4.
5.
6.

In Windows Server 2003, click the Group Policy object, and then click Edit.

In Windows Server 2008, under Group Policy Objects, right-click the Group Policy object, and
then click Edit.
In the Group Policy object editor snap-in, expand Computer Configuration, and then expand
Software Settings.
Right-click Software installation, then point to New, and then click Package.
Select the agent's installation package in the shared folder that you previously created, and then
click Open.
In the Deploy Software dialog box, click Advanced, and then click OK.
If you are reinstalling or updating the agent, do nothing.
If you are installing the agent, do the following:



On the Modifications tab, click Add, and then select the transform that you previously
created; the transform file has the name AcronisAgentWindows.mst and is located in the
same folder as the agent's installation package.
7. Click OK to close the Deploy Software dialog box.
8. If you are installing Acronis Backup & Recovery 11 Deduplication and/or Acronis Backup &
Recovery 11 Universal Restore, do the following for the appropriate installation package:
a. Right-click Software installation, then point to New, and then click Package.
b. Select the installation package in the shared folder and then click Open.
c. In the Deploy Software dialog box, click Assigned and then click OK.
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Step 3: Configuring the Group Policy object for the Agent Core component
1. Open the Acronis Core Group Policy object for editing, as follows:




2.
3.
4.
5.
6.

In Windows Server 2003, click the Group Policy object, and then click Edit.

In Windows Server 2008, under Group Policy Objects, right-click the Group Policy object, and
then click Edit.
In the Group Policy object editor snap-in, expand Computer Configuration, and then expand
Software Settings.
Right-click Software installation, then point to New, and then click Package.
Select the AcronisAgentCore.msi installation package in the shared folder that you previously
created, and then click Open.
In the Deploy Software dialog box, click Advanced, and then click OK.
If you are reinstalling or updating the agent, do nothing.
If you are installing the agent, do the following:



On the Modifications tab, click Add, and then select the transform that you previously
created; the transform file has the name AcronisAgentCore.mst and is located in the same
folder as the component’s installation package.
7. Click OK to close the Deploy Software dialog box.

2.1.5

Configuration script parameters

The configuration script mst_gen.vbs creates an .mst file (known as a transform, a modification,
or a modification file) for the installation package of an Acronis component, such as Acronis Backup
& Recovery 11 Agent for Windows.
By using the transform together with the installation package, you can install the component in the
unattended mode either by running the installation package manually or by deploying it through
Group Policy.
The following is the complete syntax of the configuration script:
mst_gen.vbs
/msi_path <Full path>
[/target_dir <Installation folder>]
[/account <User name> <Password>]
[/remote_users <User1> <User2> … <UserN>]
[/ams_address <Management server> /ams_user <Administrator name>
<Password>]
[/cep_enabled]
{/serial <License key> [/old_serial <ABR10 license
key>] | /license_server <License server> /product <Edition code>
| /online_backup | /advanced_online_backup}
[/current_user]
The script parameters are the following.
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Parameters that apply to any component
/msi_path <Full path>
Specifies a full path to the component's installation package. Enter a local path, such as
D:\folder\AcronisAgentWindows.msi; or a universal naming convention (UNC) path, such as
\\server\folder\AcronisAgentWindows.msi.
/target_dir <Installation folder>
Specifies the folder where to install the component.
Without this parameter, the component will be installed to the default folder:
%ProgramFiles%\Acronis (in a 32-bit version of Windows) or %ProgramFiles(x86)%\Acronis (in a
64-bit version of Windows).

Parameters applying only to the Agent Core component
The following parameters apply only to the installation package AcronisAgentCore.msi.
/account <User name> <Password>
Specifies the user name and password of the user account under which Acronis Managed
Machine Service will run on the machines. All agents on the machine will run as this service. The
user account must have appropriate privileges, as described in Specifying credentials for Acronis
services (p. 19). Separate the name of the domain and the account by a backslash, as in:
mydomain\User
Without this parameter, the agents will run under the default account: Acronis Agent User
/remote_users <User1> <User2> … <UserN>
Specifies the user names that will be added to the Acronis Remote Users group. Members of this
group are allowed to connect to the machine remotely.
With this parameter, only the specified users will be added to the group. Separate the user
names by spaces.
Without this parameter, all members of the Administrators group on the particular machine will
be added to the group.
/ams_address <Management server> /ams_user <Administrator name>
<Password>
Specifies the name or IP address of the Acronis Backup & Recovery 11 Management Server. With
this parameter, the machine will be registered on the management server after the installation is
complete.
/ams_user <Administrator name> <Password>
Specifies the name and password of a user who is a member of the Acronis Centralized
Admins group on the management server. Use this parameter with the /ams_address
parameter.
/cep_enabled
Specifies whether the machine will participate in the Customer Experience Program.
With this parameter, information about the hardware configuration, the most and least used
features and about any problems will be automatically collected from the machine and sent to
Acronis on a regular basis. The terms of participation can be found on the Acronis Web site.
Without this parameter, the information will not be sent.
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Parameters that apply only to a component that requires a license
The following parameters apply only to the installation packages AcronisAgentWindows.msi,
AcronisBootableComponentsMediaBuilder.msi, AcronisAgentESX.msi, AcronisAgentHyperV.msi,
AcronisUniversalRestore.msi (except the /online_backup and /advanced_online_backup
parameters), and AcronisDeduplication.msi (except the /online_backup and
/advanced_online_backup parameters).
/serial <License key>
Specifies the license key to use when installing the component. A license key is a sequence of
letters and numerals separated by dashes. Enter the license key exactly, including the dashes.
/old_serial <ABR10 license key>
When upgrading from Acronis Backup & Recovery 10 (ABR10), specifies the license key for
that product. Use this parameter with the /serial parameter.
If the license keys are stored on a license server, use the /license_server parameter
instead.
/license_server <License server>
Specifies the name or IP address of the machine where the license server is installed.
When using this parameter, also specify the /product parameter.
/product <Edition code>
Specifies the code of your edition of Acronis Backup & Recovery 11.
The codes are the following:
Acronis Backup & Recovery 11 Advanced Server: AS
Acronis Backup & Recovery 11 Advanced Server SBS Edition: SBS
Acronis Backup & Recovery 11 Advanced Workstation: AW
Acronis Backup & Recovery 11 Virtual Edition: VE
/online_backup
Specifies that the component will be installed for online backup only, with local management
capability. Neither license key nor license server is required.
/advanced_online_backup
Specifies that the component will be installed for online backup only, with local, centralized, and
remote management capability. Neither license key nor license server is required.

Parameter that apply only to the management console
The following parameter applies only to the installation packages AcronisManagementConsole.msi
and AcronisStandaloneManagementConsole.msi.
/current_user
Specifies that the component will be installed for the current user only, rather than for all users
on a machine.
Avoid using this parameter when installing the component through Group Policy, because the
“current user” in such installation is typically a system account.
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2.1.6

Installation from the management server Web page

Acronis Backup & Recovery 11 Management Server comes with its own Web server and Web page.
You or users in your organization can go to that Web page from any machine with a supported Web
browser (p. 34), and install Acronis Backup & Recovery 11 without having to specify installation
settings. When installing an agent, the setup program registers the machine on the management
server.
The Web page enables access to installation packages in a network that does not allow sharing
folders.
Unlike installation through Group Policy (p. 28), installation from the Web page can be started by the
user. It can be performed on machines that are not members of a domain, including machines
running Linux.*
Unlike remote installation (p. 25), which is often blocked by a firewall, installation from the Web
page does not require any non-standard network ports to be open. A port for HTTP (by default, port
8080) is used for installation.
For the Web page to work, the Components for Remote Installation component must be installed.
When installing the management server, check the summary page to make sure that this component
is among the components to install. You can specify the folder where to place the installation
packages.
*To add a component for Linux to the Web page, download this component from the Acronis Web site. Then
add the corresponding installed-products element to the configuration file described in "Changing
installation settings" (p. 35). This will make the component's installation file accessible via the Web page. Other
settings of the configuration file will be ignored in Linux. You need to specify installation settings manually
during every installation.

2.1.6.1

Supported Web browsers

The Web page can be accessed from any of these Web browsers:







Internet Explorer 6 or later
Mozilla Firefox 3.6 or later
Safari 5 or later
Google Chrome 6 or later
Opera 10.6 or later

Important: Make sure that JavaScript is enabled in the browser.

2.1.6.2

Using the management server Web page

To open the management server Web page, type the name or IP address of the management server’s
machine and the port number in the browser’s address bar. For example, type http://ams:8080 or
http://192.168.0.1:8080
If the Web page must be accessed through a non-default port, specify that port instead of 8080.
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Installation with pre-selected components
The following is how you can use the Web page to enable users in your organization to easily install
Acronis Backup & Recovery 11 on their machines:
1. You go to the Web page. It displays the list of components of Acronis Backup & Recovery 11 that
a user can install.
2. You select one or more components that the users need to install.
3. You copy the Download link and send it to the users.
4. A user follows the link and starts the setup program.
5. The setup program runs with all required fields (such as the name of the license server) already
filled in. The user can go through the installation wizard without changing any settings.

Installation with selecting components on-site
The following is how advanced users can use the Web page to easily install Acronis Backup &
Recovery 11 on their machines:
1. A user goes to the Web page. It displays the list of components of Acronis Backup & Recovery 11
that the user can install.
2. The user selects one or more components to install.
3. The user clicks the Download button.
4. The user starts the setup program.
5. The setup program runs with all required fields (such as the name of the license server) already
filled in. The user can go through the installation wizard and change any settings if necessary.

How installation works
The setup program itself is small in size. It downloads the installation packages of the selected
components from the management server’s machine.
When installing an agent in Windows, the setup program will create a dedicated user account for the
agent’s service.

2.1.6.3

Default installation settings

The setup program takes installation settings from the configuration file, which is stored on the
management server’s machine.
The default settings in the configuration file are the following:



To use the license server that comes with the management server. Each agent and each feature
(such as Deduplication) being installed will acquire its own license from that license server.



To install the components to the following folder:





In 32-bit versions of Windows: %ProgramFiles%\Acronis
In 64-bit versions of Windows: %ProgramFiles(x86)%\Acronis
In Linux: /usr/lib/Acronis (this setting cannot be changed)

For information about how to change the default settings, see Changing installation settings (p. 35).
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2.1.6.4

Changing installation settings

To change the default installation settings, you need to edit the configuration file.
The name of the configuration file is settings.xml. The file is stored on the machine where the
management server is installed. The file is located in the WebPage subfolder of the installation folder
you specified. By default:




When installed in a 32-bit version of Windows: %ProgramFiles%\Acronis\WebPage
When installed in a 64-bit version of Windows: %ProgramFiles(x86)%\Acronis\WebPage

This file stores settings in the following elements:
installed-products
Specifies what components appear on the Web page. Each component is specified as a
product element. For example:
<product
name="Agent for Windows"
package="AcronisAgentWindows.msi"
type="win"
description="Install the agent on a machine to be able to back up its
disks, volumes and files."
/>

The product element has the following attributes:
name
The name of the component as it appears on the Web page.
package
The name of the component’s installation package (an .msi, .i686, or .x86_64 file). The file
must be located in the folder for installation files; by default, the folder name is
%CommonProgramFiles%\Acronis\RemoteInstaller.
type
The operating system for which the component is intended. The possible values of this
attribute: win (Windows) and linux (Linux).
description
The description of the component as it appears on the Web page. The description is shown
under the name of the component.
ams
Specifies the management server (AMS) on which the machine will be registered after
installation. For example:
<ams address="ManagementServer" />

The address attribute specifies the name or IP address of the management server.
license-server
Specifies the license server from which components will take licenses during installation. For
example:
<license-server address="LicenseServer" />

The address attribute specifies the name or IP address of the license server.
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web-setup-settings
Specifies how the components will be installed.
This element has the following content:
acep
Specifies whether to enable the machine to participate in the Acronis Customer Experience
Program (CEP). The default setting is:
<acep enabled="false" />

The possible values of the enabled attribute: true (participation is enabled) and false
(participation is not enabled).
install
Specifies for which Windows users to install the components and how much interaction is
required from the user during installation. The default setting is:
<install for-user="all" mode="manual" />

The possible values of the for-user attribute: all (to install the components for all Windows
users on the machine) and current (to install the components only for the Windows user who
started the setup program).
The mode attribute is reserved for use in future versions. Its only possible value now is
manual. With this value, the setup program runs will all required fields already filled in, but
the user still must go through the installation wizard.
installation-path
Specifies where to install the components.
This element has the following content:
x86
Specifies where to install the components on machines running 32-bit versions of Windows.
x64
Specifies where to install the components on machines running 64-bit versions of Windows.
In both elements, the path attribute specifies the path. The default settings are:
<x86 path="%ProgramFiles%/Acronis" />
<x64 path="%ProgramFiles(x86)%/Acronis" />

Components for Linux are always installed to the /usr/lib/Acronis directory.

2.1.6.5

Changing the port for the Web page

By default, the Web page is available through port 8080. If another Web server already uses this
port, you will need to specify a different port.
The port number is shown on the summary screen when you install the management server. To be
able to change the port number, select the I want to manually select the Acronis components…
check box in the machine role selection window. Then, specify the port in the corresponding window.
If the management server is already installed, you can change the port number by reconfiguring the
Web server, as follows:
1. Open the httpd.conf file, which is located in the following folder:
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2. Change the value of the Listen setting to the desired port number. For example, the setting
Listen 8888 means using port 8888 for the Web page.
3. Restart the service of the Web server. You can do this in either of these ways:



At the command prompt by running the following commands:
net stop AmsWebServer
net start AmsWebServer



In the Services snap-in by right-clicking AmsWebServer and then clicking Restart.

2.1.7
2.1.7.1

Examples of installation in Windows
Example 1. Installation on a single machine

The following is a minimal installation that will enable you to back up your machine.
Install Acronis Backup & Recovery 11 as follows:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Log on as an administrator and start the setup program.
Click Install Acronis Backup & Recovery 11.
Accept the terms of the license agreement.
Select the Back up this machine's data check box, and then click Next.
When asked about installing the Deduplication and the Universal Restore features, click Next.
Click I will enter the keys manually.
Type your license key or import it from a text file.
Leave the default setting: I will register the component(s) later.
Specify whether the machine will participate in the Acronis Customer Experience Program (CEP).
Click Install.

After installation:



To start Acronis Backup & Recovery 11, click Manage Local Machine on the desktop.

2.1.7.2

Example 2. Installation on a large number of machines

Consider the following scenario:




You want to back up a large number of machines in your network.
You want to centrally set up and monitor backups of these machines.

In this scenario, you need to install the management server on one machine, and an agent on each
machine that you are going to back up. One way is to install the agents remotely.
You need a license key for each machine with an agent.
Do the following to install Acronis Backup & Recovery 11 in such environment:
Step 1: Installing the management server
1. Choose a machine that will centrally monitor other machines. This machine should be always
turned on and must be available to all machines that you are going to back up.
2. On the machine you chose, log on as an administrator and start the setup program.
3. Click Install Acronis Backup & Recovery 11.
4. Accept the terms of the license agreement.
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5. Select the Centrally monitor and configure the backing up of physical and virtual machines
check box.
6. In the license server selection window:
a. Leave the default setting: Use the license server installed along with the management
server.
b. Click Add license, and then type all your license keys or import them from a text file.
7. Click Install.
After the management server is installed, do the following to remotely install the agents on the
machines that you are going to back up. The machines will be ready for centralized management.
Step 2: Installing the agents remotely
1. Prepare the machines (p. 25) for remote installation.
2. On the machine with the management server, start Acronis Backup & Recovery 11, by clicking
Acronis Backup & Recovery 11 on the desktop.
3. Click Connect to a management server. Specify the name of the current machine.
4. In All machine actions, click Add multiple machines.
5. In the machine selection window, click From network.
6. Select the machines that you want to back up. We recommend selecting the current machine
too.
For each machine, specify the user name and password of an administrator on it. If you have a
universal administrator account for all machines (such as a domain administrator’s account),
specify it once and then click Apply to all machines.
7. In the list of components, select Acronis Backup & Recovery 11 Agent for Windows, and then
click Next.
8. In the license selection window, click Use licenses from the following license server. Specify the
current machine in IP/Name. Click Next.
9. Leave the default settings in the Installation options window.
10. Click Proceed.
After installation:



To manage the machines centrally, use the management server: on the desktop, click Acronis
Backup & Recovery 11, and then click Connect to a management server.



To manage an individual machine, you can connect to it directly: on the desktop, click Acronis
Backup & Recovery 11, and then click either Manage this machine or Manage a remote
machine.

2.1.8

Installing Acronis License Server

The license server is integrated with Acronis Backup & Recovery 11 Management Server. We
recommend using that license server.
If you need to install the license server as a separate component, use the following procedure.

To install the license server as a separate component
1. Start the setup program.
2. Click Install Acronis Backup & Recovery 11.
3. Accept the terms of the license agreement.
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4. Select the I want to manually select the Acronis components… check box, and then click Next.
5. In the list of components, under Other components, select the License Server check box, and
then click Next.
Click Import keys from file… and specify the file containing the list of license keys. You can
specify multiple files one by one or enter the license keys manually.
Details. You will be able to import additional license keys later at any moment (including when
installing the agents), by specifying a file containing the keys or by typing them in manually.
6. Use the default values for Install to: and Install for:
7. Proceed with installation.

2.2

Installation in Linux

This section describes installation of Acronis Backup & Recovery 11 components on a machine
running Linux.
By using command-line parameters, you can install the product in the unattended installation mode.

2.2.1

Preparation

RPM Package Manager
Make sure that the RPM Package Manager (RPM) is installed in your system. Before installing the
product on a Linux distribution that does not use RPM, such as Ubuntu, you need to install RPM
manually; for example, by running the following command:
sudo apt-get install rpm

Linux distributions where RPM is already installed include Red Hat Enterprise Linux, Fedora, and SUSE
Linux Enterprise Server.

Linux packages
The following Linux packages must be installed in the system: gcc, kernel, kernel-headers, and
kernel-devel. The names of these packages may vary depending on the Linux distribution.



To install these packages in Red Hat Enterprise Linux or Fedora, run the following command as
the root user:
yum install -y gcc kernel kernel-headers kernel-devel



In Ubuntu, the necessary packages are normally already installed. We recommend running the
following command before installing Acronis Backup & Recovery 11:
sudo apt-get update



For other Linux distributions, refer to the distribution’s documentation regarding the names of
these packages and the ways to install them.

Installation files
Before proceeding with installation, you need to download the installation files and assign them
necessary access permissions:
1. Go to the Acronis Web site.
2. Depending on the machine platform and your edition of Acronis Backup & Recovery 11,
download the installation file or files (.i686 or .x86_64 files).
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3. Copy the installation files to a directory on the machine where you want to install Acronis Backup
& Recovery 11.
4. Go to the directory where you copied the installation files, and then run the following command:
chmod 777 ABR11*

2.2.2

Interactive installation in advanced editions

To install Acronis Backup & Recovery 11 Agent for Linux or Acronis Bootable Media Builder
1. Make sure that you have the licenses for Acronis Backup & Recovery 11 Agent for Linux and
(optionally) Universal Restore and/or Deduplication. You can import the licenses to the Acronis
License Server.
2. Run the corresponding installation file (an .i686 or an .x86_64 file) as the root user.
3. Specify the license keys in either of these ways:




Type the DNS name or IP address of the license server.

Type your Acronis Backup & Recovery 11 license key. Likewise, you can add a license key for
the Universal Restore and/or the Deduplication feature (if purchased).
4. Specify whether you want to install the Deduplication and/or the Universal Restore feature for
the machine.
Note: You need to enable the Deduplication feature only if you are installing a full version of Acronis Backup
& Recovery 11. When using a trial version, deduplication is already enabled.

5. If you are installing the Agent for Linux, specify whether you want to register the machine on the
management server. You can add the machine to the management server later by using the
machine's name or IP address.
6. The setup program may ask you to compile the SnapAPI module for your Linux kernel. Select
Continue to compile the module now (recommended), or select Skip to compile it manually later.
Note: If the setup program could not compile the necessary module for your Linux distribution, or if you
have chosen to compile the module manually later, please refer to the file:
/usr/lib/Acronis/BackupAndRecovery/HOWTO.INSTALL

To install Acronis Backup & Recovery 11 Management Console
1. Run the installation file of the management console (an .i686 or an .x86_64 file) as the root user.
2. Follow the on-screen instructions.

2.2.3

Installation in the unattended mode

To install a component in the unattended mode (without asking for confirmations), run the
component’s installation file with the -a command-line parameter. You may need to use other
parameters (p. 42) to specify how to perform the installation.
The following are two examples of unattended installation. Both examples assume that the name of
the installation file is ABR11AgentLinux.i686.
Example 1: Unattended installation with a license key. This example applies to all editions of Acronis
Backup & Recovery 11.
The following command installs Acronis Backup & Recovery 11 Agent for Linux in the unattended
mode (without asking for confirmations) and uses the license key 12345-67890-ABCDE:
./ABR11AgentLinux.i686 -a -i BackupAndRecoveryAgent -l 12345-67890-ABCDE
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Example 2: Unattended installation with a license server. This example applies only to advanced
editions of Acronis Backup & Recovery 11.
The following command:




Installs Acronis Backup & Recovery 11 Agent for Linux in the unattended mode.



Registers the machine on Acronis Backup & Recovery 11 Management Server located on the
machine managementsrv once the installation is complete.

Uses Acronis License Server located on the machine licensesrv, and a license key for the Acronis
Backup & Recovery 11 Advanced Server edition.

./ABR11AgentLinux.i686 -a -i BackupAndRecoveryAgent -L licensesrv -P AS -C
managementsrv -g srvadmin -w PassWd123

2.2.4

Command-line parameters

When running the installation files of Acronis Backup & Recovery 11, you can specify one or more of
command-line parameters.

Parameters
Unless stated otherwise, the parameters are present in all installation files.
-a or --auto
Performs installation in the so-called unattended setup mode, as opposed to the default
interactive mode.
The setup program will proceed without asking for interaction, such as typing the license key or
clicking the Next buttons.
When using this parameter, you need to specify the component to install, by using the -i
parameter.
When running the installation file of Acronis Backup & Recovery 11 Agent for Linux or Acronis
Backup & Recovery 11 Bootable Components and Media Builder, you also need to specify the
license server or the license key by using the -L or -l parameter, respectively.
If the SnapAPI module needs to be compiled and the compilation is possible, the setup program
will automatically compile the module; otherwise, it will skip the compilation.
-n or --nodeps
Ignores dependencies during an unattended setup. This option is effective only in the
unattended setup mode (see the -a parameter described previously).
-u or --uninstall
Uninstalls the component. You do not need to specify a license key or the license server.
-s or --disable-native-shared
Forces using the setup program’s own redistributable libraries during installation, instead of
those present in the system.
Redistributable libraries are standard sets of internal tools. Programs use these libraries for
purposes such as displaying the user interface.
The setup program contains copies of all the libraries it needs. By default, it uses a copy of a
library only when no such library is present in the system. With this parameter, the setup
program always uses the copy.
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You may want to use this parameter when experiencing problems with installation; for example,
when the user interface of the setup program is not displayed correctly.
-d or --debug
Puts verbose information to the installation log.
-i <Component name> or --id=<Component name>
You do not have to specify this parameter in advanced editions. It is present for uniformity with
the command-line parameters of the installation file of Acronis Backup & Recovery 11 Server for
Linux.
Specifies the name of the component being installed:
For Acronis Backup & Recovery 11 Agent for Linux: BackupAndRecoveryAgent
For Acronis Backup & Recovery 11 Bootable Components and Media Builder:
BackupAndRecoveryBootableComponents
For Acronis Backup & Recovery 11 Management Console: ManagementConsole
The names are case-sensitive.
-e {0|1} or --ssl={0|1}
Applies only to the installation file of Acronis Backup & Recovery 11 Agent for Linux.
Specifies whether to enable authentication for connection to other components. Authentication
is performed by using Secure Socket Layer (SSL) certificates.
The possible values are:
0: Do not use authentication
1: Use authentication
-C <Management server> or --ams=<Management server>
Applies only to the installation file of Acronis Backup & Recovery 11 Agent for Linux.
Specifies the name or IP address of the Acronis Backup & Recovery 11 Management Server.
When using this parameter, you need to specify the user name and password of a management
server administrator by using the -g and -w parameters, respectively.
The machine will be registered on the management server after the installation is complete.
-g <User name> or --login=<User name>
Applies only to the installation file of Acronis Backup & Recovery 11 Agent for Linux.
Specifies the user name of a member of the Acronis Centralized Admins group on the
management server whose name is given by <Management server>.
-w <Password> or --password=<Password>
Applies only to the installation file of Acronis Backup & Recovery 11 Agent for Linux.
Specifies the password for the user whose name is given by <User name>.
-p <Port number> or --port=<Port number>
Applies only to the installation file of Acronis Backup & Recovery 11 Agent for Linux.
Specifies the number of the TCP port to use to connect to other Acronis Backup & Recovery 11
components. The default port number is 9876.
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--aur
Applies only to the installation files of Acronis Backup & Recovery 11 Agent for Linux and Acronis
Backup & Recovery 11 Bootable Components and Media Builder.
Enables the Universal Restore feature. You need to specify a license key for this feature, by using
the -l or -L parameter (see later in this section).
Note: This feature is already enabled in Acronis Backup & Recovery 11 Virtual Edition.
--dedup
Applies only to the installation files of Acronis Backup & Recovery 11 Agent for Linux and Acronis
Backup & Recovery 11 Bootable Components and Media Builder.
Enables the Deduplication feature. You need to specify a license key for this feature, by using the
-l or the -L parameter (see later in this section).
Note: This feature is already enabled in the trial version of Acronis Backup & Recovery 11.
-l <License key> or --serial=<License key>
Applies only to the installation files of Acronis Backup & Recovery 11 Agent for Linux and Acronis
Backup & Recovery 11 Bootable Components and Media Builder.
Specifies the license key for the component. Use either this parameter or the -L parameter.
If you are enabling the Deduplication and/or the Universal Restore feature (see the --aur and -dedup parameters described previously), also specify the corresponding license keys,
separating them by commas; for example:
-l 11111-AAAAA,22222-DDDDD,33333-UUUUU
-L <License server> or --license-server=<License server>
Applies only to the installation files of Acronis Backup & Recovery 11 Agent for Linux and Acronis
Backup & Recovery 11 Bootable Components and Media Builder.
Specifies the name or IP address of the Acronis License Server. Use either this parameter or the l parameter.
When using this parameter, you need to specify the code of your edition of Acronis Backup &
Recovery 11, by using the -P parameter.
-P <Product alias>
Applies only to the installation files of Acronis Backup & Recovery 11 Agent for Linux and Acronis
Backup & Recovery 11 Bootable Components and Media Builder.
Specifies the code of your edition of Acronis Backup & Recovery 11—also called the product
alias. The codes are the following:
Acronis Backup & Recovery 11 Advanced Server: AS
Acronis Backup & Recovery 11 Virtual Edition: VE
-v or --version
Displays the product version and then exits.
-? or --help
Displays help and then exits.
--usage
Displays a brief usage message and then exits.
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2.3

Installation of Agent for ESX(i)

Agent for ESX(i) enables backup and recovery of ESX(i) virtual machines without installing agents into
the guest systems.
The agent is delivered in two versions:




Agent for ESX(i) (Virtual Appliance) can be imported or deployed to a VMware ESX(i) host.
For off-loaded backup, Agent for ESX(i) (Windows) can be installed on a machine running
Windows.

Preparation
We highly recommend that you install Acronis Backup & Recovery 11 Management Server prior to
the Agent for ESX(i) installation. During the agent installation, specify the management server each
time you are asked to register the agent or prompted for a license server (unless you chose to use a
separately installed license server).

Agent for ESX(i) (Virtual Appliance)
There are three methods of installing Agent for ESX(i) (Virtual Appliance):



Importing (p. 47) to a ESX(i) host as an OVF template.
Use this method for troubleshooting purposes or if you cannot install Acronis Backup & Recovery
11 Management Server for some reason.



Deployment from Acronis Backup & Recovery 11 Management Server to a specified host or
cluster.
Connect the console to the management server. In the Navigation tree, right click Virtual
machines, then click Deploy Agent for ESX(i). Refer to the context help for further instructions.



Automatic deployment from Acronis Backup & Recovery 11 Management Server.
This is the easiest method. It is recommended in most cases. Connect the console to the
management server. In the Navigation tree, right click Virtual machines, and then click Configure
VMware vCenter integration. Specify the vCenter Server, and then enable Automatic
deployment. Any time a virtual machine is selected for backup but the agent is not installed on
its host, the Virtual Appliance will be automatically deployed on the host when the backup starts.

Agent for ESX(i) (Windows)
If your production ESX(i) hosts are so heavily loaded that running the virtual appliances is not
desirable, consider installing Agent for ESX(i) (Windows) on a physical machine outside the ESX
infrastructure.
If your ESX(i) uses a SAN attached storage, install the agent on a machine connected to the same
SAN. The agent will back up the virtual machines directly from the storage rather than via the ESX(i)
host and LAN. This capability is called a LAN-free backup.
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The diagram below illustrates a LAN-based and a LAN-free backup. LAN-free access to virtual
machines is available if you have a fibre channel (FC) or iSCSI Storage Area Network. To completely
eliminate transferring the backed up data via LAN, store the backups on a local disk of the agent's
machine or on a SAN attached storage.

Agent for ESX(i) (Windows) can be installed on any machine that runs Windows and meets the
system requirements (p. 14). Follow the instructions described in the "Interactive installation in
advanced editions" (p. 18) section.
During installation, specify the vCenter Server or ESX(i) Server whose virtual machines the agent will
back up.
You will be able to set or change this setting at a later time. To access this setting after the agent has
been installed, connect the console to the machine with the agent and select from the top menu
Options > Machine options > Agent for VMware vSphere ESX(i) (Windows).

Providing licenses
None of the installation methods results in consuming a license. The licenses will be required later.
Once you configure the first backup of virtual machines, one license will be assigned to each ESX(i)
Server that hosts a machine selected for backup.
If you have n ESX(i) servers, it is recommended that you purchase n Virtual Edition licenses and
import them to the license server or to the management server before configuring the first backup. If
you are planning to add more virtualization servers to your environment, upload a few more licenses
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in advance. This will ensure uninterrupted operation of your backup plans even if machines included
in it migrate to a new server.

2.3.1

Importing Agent for ESX(i) (Virtual Appliance)

Use this method for troubleshooting purposes or if you cannot install Acronis Backup & Recovery 11
Management Server for some reason. In all other cases, please follow the instructions provided in
the previous section.

2.3.1.1

Step 1: Extracting the OVF template

1. On a machine running Windows, start the Acronis Backup & Recovery 11 setup program.
2. Click Extract installation files. Then, in the list of installation packages, select the Agent for ESX(i)
Virtual Appliance (AcronisVirtualAppliance.msi) check box.
Tip: Alternatively, you can click Install Acronis Backup & Recovery 11, select the I want to
manually select the Acronis components... check box, and then select the Agent for ESX(i)
(Virtual Appliance) check box in the list of components. Complete the installation and skip steps
3 and 4.
3. In Extract to, specify the folder to which you want to extract the virtual appliance's installation
package, and then click Extract.
4. Run the installation package.
After the installation is complete, the virtual appliance's files will be located in the folder
%ProgramFiles%\Acronis\ESXAppliance. Share this folder for read, if you run the vSphere Client on a
different machine.

2.3.1.2

Step 2: Deploying the OVF template

1. Start the vSphere Client and log on to the ESX(i) server.
2. On the File menu, point to Deploy OVF Template. Follow the Deploy OVF Template wizard.
Tip. In VMware Infrastructure, point to Virtual Appliance, and then click Import. Follow the
Import Virtual Appliance wizard.
3. In Source, select Deploy from File, and then specify the path to the virtual appliance's OVF
package—normally: %ProgramFiles%\Acronis\ESXAppliance.
4. Review the OVF Template Details and click Next.
5. In Name and Location, type the name for the appliance or leave the default name
AcronisESXAppliance.
6. In Network mapping, select the bridged mode for the network adapter.
7. In Datastore, leave the default datastore unless it does not have enough space for the virtual
appliance. In this case, select another datastore. Skip this step if there is only one datastore on
the server.
8. Review the summary and then click Finish. After the successful deployment is reported, close the
progress window.

2.3.1.3

Step 3: Configuring the virtual appliance

1. Starting the virtual appliance
In the vSphere Client, display the Inventory, right-click the virtual appliance's name, and then
select Power > Power On.
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Select the Console tab. The virtual appliance welcome screen tells you what to do next. Click
Close. You will be able to access this screen at any time by clicking the help button in the virtual
appliance GUI.
You are taken to the Acronis Backup & Recovery 11 Agent for VMware vSphere ESX(i) screen
where you continue the agent configuration.
2. Time zone
Under Virtual machine, in Time zone, click Change and select the time zone for the location
where the management console is installed.
An ESX(i) server always works in the GMT time zone. When being imported, a virtual appliance
inherits the GMT time zone from the server. If the console works in another time zone, you need
to synchronize the virtual appliance with the console to ensure that the tasks scheduled with the
console run at the appropriate time.
3. vCenter/ESX(i)
Under Agent options, in vCenter/ESX(i), click Change and specify the vCenter Server name or IP
address. The agent will be able to back up and recover any virtual machine managed by the
vCenter Server.
If you do not use a vCenter Server, specify name or IP address of the ESX(i) host whose virtual
machines you want to back up and recover. Normally, backups run faster when the agent backs
up virtual machines hosted on its own host.
Specify the credentials that the agent will use to connect to the vCenter Server or ESX(i). We
recommend that the account have the necessary privileges for backup and recovery on the
vCenter Server or ESX(i). You can click Check connection to ensure the access credentials are
correct.
The virtual appliance is ready to work. In addition, you can change the following settings:



Network settings
The agent's network connection is configured automatically by using Dynamic Host Configuration
Protocol (DHCP). To change the default configuration, under Agent options, in eth0, click Change
and specify the desired network settings.



Local storages
You can attach an additional disk to the virtual appliance so the Agent for ESX(i) can back up to
this locally attached storage. Such backup is normally faster than a backup via LAN and it does
not consume the network bandwidth.
The virtual disk size must be at least 10 GB. Add the disk by editing the settings of the virtual
machine and click Refresh. The Create storage link becomes available. Click this link, select the
disk and specify a label for it.
Be careful when adding an already existing disk. Once the storage is created, all data previously contained
on this disk will be lost.

2.3.1.4

Step 4: Adding the virtual appliance to the management server

The minimum set of components that enables backing up virtual machines from a host includes the
management console, the license server and the agent. With this set, you can back up and recover
virtual machines using the direct console-agent connection.
However, Acronis highly recommends that you install and use Acronis Backup & Recovery 11
Management Server, even if you have only one ESX(i) host. The management server lets you easily
deploy and update agents, set up and monitor backups of your virtual machines. If, for better
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performance, you configure several agents to manage the same host, the management server will
automatically distribute virtual machines between the agents. This is necessary to equalize the
agents' load and to avoid a conflict of snapshots which may occur if two agents try to back up a
virtual machine simultaneously.
If you are planning to use the management server, register the virtual appliance on the server.

To add the virtual appliance to the management server
1. Start Acronis Backup & Recovery 11 Management Console.
2. Connect the management console to the virtual appliance using the IP address displayed in the
virtual appliance console.
3. Select Options > Machine options > Machine management from the top menu.
4. Select Centralized management and specify the management server IP/name. Click OK.
5. Specify the user name and password for the management server administrator's account. Click
OK.
Alternatively, you can add the appliance to the management server on the server's side.

2.3.2

Updating Agent for ESX(i) (Virtual Appliance)

Update from the management server
This update method applies only to those virtual appliances that are registered on the management
server. This method is preferable to the manual procedure described later in this section, because all
configuration settings (local backup plans, centralized backup plans and group membership) related
to the virtual machines managed by the agent will be preserved in this case.

To update the virtual appliances from the management server
1. Update the management console and the management server.
2. Connect the console to the management server.
3. In the Navigation tree, right-click the group that has the same name as the vCenter Server. If
VMware vCenter integration is not enabled, right-click Virtual machines.
4. Click Update Agent for ESX(i).
5. Select the agents that you want to update. Agents that are already of the latest version are
unavailable for selection.
6. Click Update Agent for ESX(i).
The virtual appliances will be updated; the agents' configuration settings will be preserved.

Manual update
Manual update of the virtual appliance involves installing a new appliance and deleting the old one.
Use this method only if updating from the management server is not possible for some reason.
After manually updating the virtual appliance, you will have to re-create local backup plans that
existed on the appliance.

To update the virtual appliance (VA) manually
1. Install and configure the new VA, as described in "Importing Agent for ESX(i) (Virtual Appliance)"
(p. 47).
2. Delete (p. 56) the old virtual appliance from the ESX(i) server.
49

Copyright © Acronis, Inc.

3. [Optional] Re-create local backup plans that previously existed on the VA if you want to continue
using them.
4. [Optional] Re-establish the machines' membership in dynamic groups that use the All VMs
backed up by agent criterion. To do this, specify the updated VA as a criterion for the group.
Details. The machines' membership in such dynamic groups is lost because the old VA is removed
from the management server during update.
You do not need to re-add either static or dynamic custom groups to the centralized backup plans. As
soon as the machines' membership in the groups is re-established, the appropriate backup plans will
continue protecting the machines.

2.4

Installation of Agent for Hyper-V

Agent for Hyper-V enables you to back up and recover virtual machines from a Hyper-V host without
installing agents on the virtual machines.

Preparation
Licenses. Make sure that you have a sufficient number of licenses for Virtual Edition. You need one
license per Hyper-V host. If you have a Hyper-V cluster (also called a failover cluster), we recommend
obtaining licenses for each node of the cluster.
Management server. We recommend installing Acronis Backup & Recovery 11 Management Server
and importing the licenses. If you have a Hyper-V cluster, installing the management server will
enable you to back up clustered virtual machines whatever node they are running on.

Installation
Install the agent on the Hyper-V host. In a Hyper-V cluster, install the agent on each node of the
cluster.



In Windows 2008/2008 R2, you can install the agent from the setup program (p. 18). Select the
Back up this machine's data check box and follow the onscreen instructions.



In Microsoft Hyper-V Server 2008/2008 R2, you can install the agent remotely (p. 25).

When installing the agent, provide the license key, either manually, or by specifying the management
server or the license server.
If prompted for the Acronis Managed Machine Service (agent) account, specify an account of a
domain user who has administrative privileges on all nodes of your Hyper-V cluster. With this
account the agent will be able to access virtual machines on any of the nodes. Alternatively, you can
choose to create a new account for the agent. Then, when creating centralized backup plans or
recovery tasks, you will need to specify credentials for the domain account with the necessary
privileges.
If you installed the management server, choose to register the agent on it during installation.
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3 Upgrading from trial to full product version
The trial key required at installation can be obtained on the Acronis Web site.
To upgrade from the trial version to the standard product you do not need to re-download the
software. When the trial period is over, the product GUI displays a notification requesting you to
specify a standard license key.
To specify the standard license key, use the Change License window in the management console.
Specifying the standard key by running the setup program is not possible.

3.1

Limitations of the trial version

The Acronis Backup & Recovery 11 trial version has the following limitation:



Universal Restore functionality is disabled.

Additional limitations for bootable media:



The disk management functionality is not available. You can try the user interface, but there is no
option to commit the changes.



The recovery functionality is available, but the backup functionality is not. To try the backup
functionality, install the software in the operating system.

3.2

Changing a license

By changing the license, you switch to a different version or edition of the product. The following
table summarizes the available options.
Switching a license

Why you may need it

trial > full

Upgrade from trial to full product version

trial > trial different edition

Define the edition that better fits your needs

trial > full different edition

The edition you bought differs from the edition of the trial version

You can also enable Acronis Deduplication and Acronis Universal Restore by using additional licenses,
if these are available for the version and edition you are switching to.
Switching between advanced and standalone editions is not possible.
Before switching to a full version of an advanced edition
If you are planning to change licenses on a large number of machines, you may want to add (import)
the full license keys to Acronis License Server.
Acronis Deduplication is always enabled in trial product versions. If you want to continue using this
functionality, please do not forget to:
1. Purchase Acronis Deduplication licenses.
2. Import the Acronis Deduplication license keys to the license server (recommended).
3. Use one Acronis Deduplication license for every machine where Acronis Backup & Recovery 11 is
upgraded to the full version.
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You can do this later at any time, however, until that time backup to deduplicating vaults will fail.

To change a license in advanced editions:
1. Do either of the following:




Connect the console to the machine and click Help > Change license.



If the currently used licenses are stored on the license server, select the edition to switch to.
If the Acronis Deduplication or Acronis Universal Restore licenses for this edition are
available on the license server, specify whether to use each of these licenses. To add one or
more licenses to the license server, click Add license.



Otherwise, enter the license keys manually.

Connect the console to the management server, navigate to Machines with agents, Virtual
machines, or to another group that displays the machine whose license you want to change,
right-click the machine, and then click Change license.
2. Do either of the following:

To change licenses on multiple machines running Windows, we recommend using the remote
installation functionality (p. 25).
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4 Checking for software updates
Each time you start the management console, Acronis Backup & Recovery 11 checks whether a new
version of the software is available on the Acronis Web site. If so, the software provides a link for
downloading a setup program of the new version.
To check for updates manually, start the management console and then click Help > Check for
updates. In that window, you also can disable the automatic checks for updates.
For information about updating Acronis Backup & Recovery 11, see the “Update” section (p. 25) (for
local installation in Windows) or the corresponding installation section (for other ways of
installation).
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5 Uninstalling Acronis Backup & Recovery 11
This section describes uninstallation of Acronis Backup & Recovery 11.

5.1

Uninstalling advanced editions of Acronis Backup &
Recovery 11

When you uninstall a component that uses a license on Acronis License Server, the license remains
assigned to the machine. If you want to use this license for a different machine, revoke the license
manually.

5.1.1

Uninstallation in Windows

5.1.1.1

Interactive uninstallation

To uninstall Acronis Backup & Recovery 11 or its components, we recommend using the following
procedures instead of the Add or Remove Programs or Programs and Features tool of Windows.

To uninstall all components of Acronis Backup & Recovery 11
1. Click Start -> All Programs -> Acronis -> Uninstall Acronis Backup & Recovery 11.
2. To delete associated information (see later in this topic), select the Remove the product's log,
tasks, vaults and configuration settings check box.
3. Click Remove.

To uninstall individual components or features of Acronis Backup & Recovery 11
1.
2.
3.
4.

Start the Acronis Backup & Recovery 11 setup program.
Click Install Acronis Backup & Recovery 11.
Click Modify.
Clear the check boxes next to the names of the components or features that you want to
uninstall.
5. To delete associated information (see later in this section), select the Remove the product's log,
tasks, vaults and configuration settings check box.

Deleting associated information
If you are planning to reinstall a component at a later time, you may want to keep its associated
information.
If instead you want to delete this information, select the Remove the product's log, tasks, vaults and
configuration settings check box. As a result, the following information will be deleted:



When uninstalling Acronis Backup & Recovery 11 Agent for Windows: the log and tasks of the
agent



When uninstalling Acronis Backup & Recovery 11 Management Server: the management server
databases, which store the configuration of centralized backup plans, the operation log, and
statistics



When uninstalling Acronis Backup & Recovery 11 Storage Node: the log and tasks of the storage
node
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5.1.1.2

Unattended uninstallation

To uninstall a component or feature of Acronis Backup & Recovery 11 in the unattended mode, you
need to run the msiexec utility. This utility uses the corresponding installation package (an .msi file).

To uninstall a component or feature
1. Extract the corresponding installation package to a folder or a network share.
2. Run the following command (here, the installation package is assumed to be
AcronisAgentWindows.msi, saved in the \\myserver\share network share):
msiexec /uninstall \\myserver\share\AcronisAgentWindows.msi /qb

Uninstalling an agent
When you uninstall an agent, we recommend first uninstalling its features, then the agent itself and
then the Acronis Backup & Recovery 11 Agent Core component.
For example, if the agent is installed with the Universal Restore feature, run uninstallation
commands in the following order:
msiexec /uninstall \\myserver\share\AcronisUniversalRestore.msi /qb
msiexec /uninstall \\myserver\share\AcronisAgentWindows.msi /qb
msiexec /uninstall \\myserver\share\AcronisAgentCore.msi /qb

Uninstalling the license server
If you need to uninstall the Acronis License Server, you should do so after uninstalling all agents that
use it. Also keep in mind that the license server may be used by other Acronis products.
The license server is integrated with the management server. To uninstall the management server,
run the following command (change the path if needed):
msiexec /uninstall \\myserver\share\AcronisManagementServer.msi /qb

To uninstall the license server installed as a separate component, run the following command
(change the path if needed):
msiexec /uninstall \\myserver\share\AcronisLicenseServer.msi /qb

5.1.2

Uninstallation in Linux

To uninstall all components of Acronis Backup & Recovery 11
Do the following as the root user:
1. Run the following commands to uninstall Acronis Backup & Recovery 11 components:
# /usr/lib/Acronis/BackupAndRecovery/uninstall/uninstall
# /usr/lib/Acronis/BootableComponents/uninstall/uninstall
# /usr/lib/Acronis/BackupAndRecoveryConsole/uninstall/uninstall

2. Run the following command to delete the source files of the SnapAPI module:
# rm -rf /usr/src/snapapi*

To uninstall all components in the unattended mode, run each of the ./uninstall commands with the
-a parameter.
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5.2

Deleting ESX(i) Virtual Appliance

Acronis Backup & Recovery 11 Management Server provides an easy way to remove Agent for ESX(i) from ESX
or ESXi servers. You might generally prefer that method to the procedure described later in this section.
Connect the console to the management server. In the Navigation tree, right-click Virtual machines, then click
Remove Agent for ESX(i). Refer to the context help for further instructions.

You may need to manually delete the Agent for ESX(i) (Virtual Appliance), or VA, in the following
cases:

 The VA is not registered on the management server.
 You are not using vCenter Server or integration with vCenter Server is not enabled.
 The VA is corrupted.
To remove Agent for ESX(i) (Virtual Appliance) manually
1. Start VMware vSphere Client and log on to the ESX(i) host or to vCenter Server.
2. Power off the VA.
3. If the VA uses a locally attached storage on a virtual disk, and you want to preserve data on that
disk, do the following:
a. Right-click the VA, and then click Edit Settings.
b. Select the disk with the storage, and then click Remove. Under Removal Options, click
Remove from virtual machine.
c. Click OK.
As a result, the disk remains in the datastore. You can attach the disk to another VA.
4. Right-click the VA, and then click Delete from Disk.
5. Remove the VA from the management server. Skip this step if the appliance is not registered on
the management server or has been already removed.
To remove the VA, connect to the management server, right-click the VA in the All physical
machines list, and then click Delete machine from AMS.

5.3

Deleting Acronis Secure Zone

Uninstallation of Acronis Backup & Recovery 11 does not affect Acronis Secure Zone and its contents.
You will still be able to recover data from Acronis Secure Zone on booting from bootable media.
If you need to delete Acronis Secure Zone, perform the following steps in the operating system
(before the agent uninstallation) or under bootable media.

To delete Acronis Secure Zone
1. On the Actions menu, click Manage Acronis Secure Zone.
2. In the Delete Acronis Secure Zone window, select volumes to which you want to add the space
freed from the zone and then click OK.
If you select several volumes, the space will be distributed proportionally to each partition. If you
do not select any volume, the freed space becomes unallocated.
After you click OK, Acronis Backup & Recovery 11 will start deleting the zone.

56

Copyright © Acronis, Inc.

